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Grafische Programmierplattform
• Rapid Application Development und 

Rapid Prototyping
• Ereignissteuerung, Objektorientierung

und Verteilte Anwendungen
• Targets:  Real-Time, FPGA, PDA, 

Embedded, DSP, etc.
• Versionen in engl., dt. fr., jap., chin.

Erfassen, Analysieren und  Präsentieren
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PC, Mac, Linux, Sun

LabVIEW Everywhere

Networked I/O

PC Boards

Workstation

Handheld

Embedded
(FPGA)

Industrial Computer (PXI)

Wireless

Sensor

Tektronix Open Windows 
Oscilloscopes
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Kursübersicht

LabVIEW
Einführung

Schleifen und
Wiederholungen

Modulare
Programmierung

VI Anpassung

Data Acquisition
& Waveforms

Instrument 
Control

Arrays

Daten plotten

Cluster

Entscheidungs-
findung in VIs

Strings und 
File I/O
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Lektion 1
Einführung in LabVIEW

Themen
LabVIEW Entwicklungsumgebung
Front Panel
Block Diagram
Datenflussprogrammierung
LabVIEW Hilfe und Dokumentation
Fehlersuche und Debugging
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Virtuelle Instrumente (VIs)

Front Panel
• Controls = Eingabeelemente
• Indicators = Anzeigeelemente

Block Diagram
• Sourcecode
• Komponenten verdrahtbar
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Neue Elemente erzeugen
• File»New VI to open a blank VI

• File»New… ermöglicht die Erzeugung neuer Eelemente wie
Templates (Vorlagen), Controls, glob. Variablen, VIs, etc.
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Template Browser
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Front Panel (FP)
Front Panel 
Toolbar

Graph
Legende

Boolean
Control

Waveform
Graph

Icon

Plot
Legende

Scalen
Legende

Waveform
Graph
Label

Menüleiste
Titelleiste
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Block Diagramm (BD)

Wire 
Data

Graph
Terminal

SubVI

While Loop
Structure

Block 
Diagram 
Toolbar Divisions

Funktion

Numerische
Konstante

Timing 
Function

Boolean Control 
Terminal

MenüleisteTitelleiste
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Front Panel und Block Diagramm Werkzeugleisten

Run button 
Continuous Run button
Abort button
Pause/Continue button

• Execution Highlighting button
• Step Into button
• Step Over button
• Step Out button

Warning indicator

Enter button

Broken Run button

Font ring
Alignment ring
Distribution ring
Resize ring
Reorder ring
Context Help Button

Additional Buttons on the 
Block Diagram Toolbar
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Tools Palette

• LabVIEW kann automatisch Werkzeuge selektieren

• Manuelle Selektion mit Leertaste (2 wichtigste Elemente) oder Tab-
Taste (4 wichtigste Elemente)

• Im FP und BD verfügbar

• Werkzeuge sind Instanzen von Mauszeigeroptionen

• Werkzeuge ermöglichen die Veränderung von Elementen in FP und BD

• Anzeige mit Window»Show Tools Palette oder Shift+PopUp
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Front Panel − Controls Palette

Controls Palette

All Controls Palette
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Block Diagram − Functions Palette

Functions Palette
Express VIs

All Functions Palette
Alle Funktionen
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Palette Tools

• Grafische “fließende” (auf Desktop frei bewegbare) Paletten
• Subpaletten können in “floating palettes” konvertiert werden
• Mit den Optionen kann zwischen Express und  Advanced 

Palettensubset umgeschaltet werden

Suche Optionen

Pin, um Palette zu selektieren

Eltern-
Palette
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Suche nach Controls, VIs und Funktionen
• Search-Knopf für

Textsuche
• “Click and drag”-

Funktionalität um Elemente
in BD zu bringen. Mit
Doppelklick wird
Elternpalette geöffnet.
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Anpassungen von Control & Funktions Paletten

• vi.lib muss im LabVIEW Verzeichnis bleiben
• I.d.R. nur user.lib oder instr.lib erweitern um neue

Elemente hinzuzufügen

Programme» National Instruments»LabVIEW 8.x
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Erzeugen des Front Panels durch Platzieren von Eingabeelementen
(Controls) sowie Anzeigeelementen (Indicators) und dekorativen
Elementen (Decorations)

Numeric
Control 

Numeric
Indicator Owned 

Labels

Increment
Buttons

Boolean
Control 

Boolean
Indicator 

VI Front Panel erzeugen
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Shortcut Menüs für Front Panel Objekte

Rechtsklick auf Elemente ermöglicht die 
Einstellung von Optionen
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Property Page (Eigenschaftsseiten)
Rechtsklick auf Elemente
und Auswahl “Properties”
ermöglicht die Einstellung
von Eigenschaften
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NodesWires

Control
Terminals

Block DiagrammFront Panel
Indicator 
Terminals

VI Block Diagramme erzeugen
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Express VIs, VIs und Funktionen
• Express VIs: Interaktive VIs mit konfigurierbaren Dialogen
• Standard VIs: modularisierte VIs, Anpassung über Terminals
• Functions: LabVIEWs fundamentale Elemente; FP und BD 

nicht vorhanden
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Block Diagramm – Darstellung von VIs

Icon                               Expandable Node Expanded Node 

• Function Generator VI
• Drei Darstellungen
• Links: Standard VI
• Mitte und rechts: Express VI
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Block Diagramm Terminals
• Terminals sind Ein- und 

Ausgangsstellen um Informationen
zwischen VIs sowie FP und BD 
auszutauschen

• Terminals sind vergleichbar mit
Parametern in textbasierten
Programmiersprachen

• “ View As Icon” über rechte
Maustaste ein- und ausschaltbar
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Block Diagramme verdrahten Darstellung

Scalar

Numeric

Boolean

String

2D Array1D Array

Dynamic
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Wiring Techniques 
Hot Spot

• Automatische Verdrahtung (aut. Wiring)
• Context Help Fenster (STRG+H) ist nützlich beim Verdrahten
• Rechtsklick auf  Draht + Clean Up Wire optimiert Verdrahtung
• Tip Strips verwenden
• Automatic wire routing
• Rechtsklick auf Terminals 

und selektieren Visible 
Items»Terminals

Anzeige von Terminalverbindungen in einer Funktion
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• Datenfluss analog zu
Stromfluss (Datenquelle zu
Datensenke)

• Knoten werden abgearbeitet, 
wenn alle Eingangsterminals
gültige Daten haben

• Nach der Abarbeitung stehen
Informationen an den 
Ausgangsterminals zur
Verfügung

Dataflow Programming
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Kontexthilfe
• Help»Show Context Help, <STRG-H> oder Show 
Context Help Window Knopf in Werkzeugpal.

• Hilfe Anzeigen durch Mauscursor über Objekt
• Verbindungen:
Required – fett
Recommended – normal
Optional - angegraut

Simple/Detailed Context Help       Lock Help          More Help
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LabVIEW Hilfe
• Klicke auf More Help Knopf in Kontext Hilfe
• Wähle Help»VI, Function, & How-To Help
• Klicke auf Click here for more help in Kontext Hilfe
• Detaillierte Hilfe rund um LabVIEW
• Wichtig: Verwaltung von Favoriten
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NI Example Finder
• Help»Find Examples um 

Beispiele zu suchen
• Web-Integration
• Vielfältige Suchoptionen
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Debugging Techniken
Finding Errors

Klicken auf gebrochenen Pfeil listet Fehler
Execution Highlighting

Execution Highlighting ermöglicht Visualisierung des 
Datenflusses (Bläschen auf Drahten, Skalare Werte und 
Anzahl Arrayelemente auf Terminals) 
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Debugging Techniques
Probe Rechtsklick auf Draht und Auswahl

Breakpoints
Rechtsklick auf Draht und Auswahl Set Breakpoint; Hält
Abarbeitung an diesem Punkt an (Pause) und ermöglicht
Einzelschrittbetrieb

Conditional Probe
Kombination von Breakpoint und Probe.  (mit Rechtsklick
wählbar)
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Debugging Techniken (Einzelschrittbetrieb)
Step Into, Step Over, Step Out Knöpfe

Schritt in Knoten

Schritt über Knoten

Schritt aus Knoten heraus
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Tipps
• Tastatur-Shortcuts:

• Zugriff auf Tools Palette mit <shift>-Rechtsklick
• Increment/Decrement schneller durch Drücken der <shift> - Taste
• Tools»Options: Voreinstellungen für LabVIEW Umgebung
• VI Properties (File Menü Voreinstellungen für einzelne VIs)
• Stoppen von VIs durch Tastenkombination <STRG>+.

Windows      Sun        Linux       MacOS
<Ctrl-R> <♦-R> <M-R> < -R> Run a VI
<Ctrl-F> <♦-F> <M-F> < -F> Find object
<Ctrl-H> <♦-H> <M-H> < -H> Activate Context Help window
<Ctrl-B> <♦-B> <M-B> < -B> Remove all broken wires
<Ctrl-W> <♦-W> <M-W> < -W> Close the active window
<Ctrl-E> <♦-E> <M-E> < -E> Toggle btwn Diagram/Panel Window
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Lektion 2
Modulare Programmierung

Themen
SubVIs
Icons und Connector Pane
SubVIs

36

LabVIEW Hierarchie

SubVI
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SubVIs

Function Pseudo Code
function average (in1, 
in2, out)

{
out = (in1 + in2)/2.0;
}

SubVI Block Diagram

Calling Program Pseudo Code
main
{
average (point1, point2, 
pointavg)

}

Calling VI Block Diagram
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Icon/Connector

•Icons repräsentieren VIs in Elternblockdiagrammen
•Daten mit diesem VI werden über Terminals ausgetauscht

Icon

Connector

terminals

terminals
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SubVI Beispiel – Berechnung einer Steigung
• VI innnerhalb eines übergeordneten VI nennt man subVI
• Nach dem Editieren des Front Panels und des Blockdiagramms ist die 

ICON Pane und das Icon zu editieren. Beschreibungen nicht vergessen
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Icons erzeugen und verändern
• Icon: Grafische Repräsentation eines VIs
• Rechtsklick auf icon pane (Panel oder Diagramm)
• Immer alle Instanzen erzeugen
• Zwischenablage verwendbar über Shortcuts

Default Icon 
(aut. Durch LV 
durchnummeriert)

Kundenspez. Icon (besser)
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Konnektoren editieren

Rechtsklick auf Pane
(nur bei Front Panel)
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Verbindungen erzeugen
Klick mit
Wiring Tool
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Die Connector Pane
Farben werden je nach Typ zugewiesen

44

VIs als SubVIs benutzen

All Functions » Select a VI…
<ODER>

Ziehe Icon auf Zieldiagramm
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Klassifizierung von Terminals und Hilfe

Klassifiziere Terminals
• Required — Muss verdrahtet werden sonst Fehler
• Recommended — Warnung wenn nicht verdrahtet
• Optional — kein Effekt falls nicht verdrahtet
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Create SubVI Option
• Schließe Bereich ein
• Verwende Create SubVI aus Edit Menü
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Lektion 3
Schleifen und Wiederholungen

Themen
While Loops
For Loops
Zugriff auf Daten zurückliegender Iterationen
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While Loops

LabVIEW While Loop Flow Chart Pseudo Code

Repeat (code);

Until Condition met;

End;
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While Loops
1. Wähle While Loop 2. Schließe zu wiederholenden Code ein

3. Füge zusätzliche Elemente ein und verdrahte

50

Loop Condition 
Klicke auf Conditional Terminal mit dem Operating tool um 
das Abschaltverhalten zu ändern
Default: Stop if True

Iteration Terminal Conditional Terminal
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Structure Tunnels
• Tunnels ermöglichen die Datekommunikation von und zu

Strukturen
• Tunnels sind Blöcke am Strukturenrand die die direkte

Kommunikation von und zu Strukturen ermöglichen
• Abarbeitung der Elemente erst nach Anliegen von Daten
• Daten werden erst nach Abarbeitung innerhalb der Struktur

aus der Struktur ausgegeben
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For Loops

LabVIEW For Loop Flow Chart Pseudo Code

N=100;

i=0;

Until i=N:

Repeat (code; i=i+1);

End;
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For Loops
• In Structures Subpalette der Funktionspalette

• Führt Struktureninhalt eine fest gelegte Anzahl von 
Iterationen aus

Count terminal
(Numerical input)

Wait Until Next 
ms Multiple
function
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Wait Functions
Wait Until Next 
ms Multiple

Functions»Time 
& Dialog palette
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Wait Functions
Wait (ms)

Functions»Time 
& Dialog palette

Time Delay

Functions»Time 
& Dialog palette
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Numeric Conversion
• Numerics haben standardmäßig double-precision (8 bytes) oder long 

integer (4 bytes) Repräsentationen
• LabVIEW konvertiert automatisch (falls möglich)
• For Loop count terminal konvertiert immer in Long Integer
• Gray coercion dot oder roter Punkt (ab LV 8.0) zeigt Konvertierung an
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Numerische Konvertierung
• LabVIEW verwendet die hochauflösendere Repräsentation
• Mit Recchtklick kann man die Repräsentation auswählen.

• Wenn LabVIEW Fließkommawerte in Ganzzahlwerte wandelt, 
rundet es auf den nächstliegenden Integerwert (z.B. rundet
LabVIEW 2.4 auf 2 und 3.6 auf 4)
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Zugriff auf zurückliegende Schleifendaten –
Shift Register (Schieberegister)
Verfügbar am linken Schleifenrand
• Rechtsklick am Schleifenran und Auswahl “Add Shift Register”
• Rechtes Terminal speichert Daten nachg Umlauf
• Linkes Terminal übernimmt gespeicherte Daten für den nächsten Umlauf

Vor
Abarbeit

ung
1. 

Umlauf
2. 

Umlauf
3. 

Umlauf

Initial Value

Value 1

Value 1

Value 2

Value 2

Value 3

Wert 3Initial
wert
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Zusätzliche Shift Register Elemente

Latest value
is passed to
right terminal

Rechtsklick
und
Aufziehen
ermöglicht
mehr
Terminals

Previous values are available at 
the left terminals

Rechtsklick
Ermöglicht
weitere
Schieberegister

1 loop ago

2 loops ago

3 loops ago
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Feedback Nodes

• Andere Darstellung für Schieberegister
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Feedback Nodes
• Erzeugt durch Verbindung von 

Outputs zu Inputs 
<Oder>

• Platzieren über
Functions»Structures Palette 
Analog zu Schieberegistern
<Oder>

• Durch Konvertierung der
Schieberegister
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Initialiierte Shift Registers & Feedback Nodes

1. Umlauf VI stoppt 2. Umlauf

Output = 5Output = 5

Output = 5 Output = 5
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Nicht initialisierte Shift Registers & Feedback Nodes

Output = 8Output = 4

Output = 4 Output = 8

1. Umlauf VI stoppt 2. Umlauf
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Lektion 4
Arrays

Themen
Arrays - Einführung
Auto Indexing Arrays
Array Funktionen
Polymorphie
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• Ansammlung von Daten gleichen Typs
• Ein/mehrdimensional, max. 2          Elemente pro Dimension
• Zugriff auf Elemente über Index; erstes Element hat immer Index 0

31

index
10-Element Array 1.2 3.2 8.2 8.0 4.8 5.1 6.0 1.0 2.5 1.7

0     1     2     3     4     5     6     7     8     9

2D array

2-dim. Array mit 7 Spalten und 5 Reihen (35 Elemente) 

0    1    2     3    4     5    6
0 
1 
2 
3
4

Arrays
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Erweitere ggf. 
Dimension
(nD Arrays)

1. Wähle Array Shell (Controls 
Palette)

2. Ziehe Datentyp in Shell

Array Controls und Indicators
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1. Wähle Array 
Shell (Functions 
Palette)

2. Ziehe Datentyp in Shell und 
initialisiere

Zugriff auf  Array Konstanten
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• Mit Autoinexierung
können Arrays erzeugt
werden (For Loops 
auto-index 
standardmäßig)

• While Loops (While 
Loops geben
standardmäßig letzten
Wert ausd) 

• Rechtsklick auf Tunnel 
ermöglicht
Veränderung der
Indexingfunktion

Auto-Indexing
Drähte werden dicker

Drähte bleiben gleich dick

Auto-Indexing Disabled

Auto-Indexing Enabled

Nur ein Wert wird
ausgegeben

1D Array

0    1     2     3    4     5
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• Innere Schleife erzeugt Spaltenelemente
• Äußere Schleife setzt diese Elemente in Zeilen

Erzeugen von 2D Arrays

1D Array

0    1     2     3    4     5

2D Array
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Auto-Index Input
• Array Input kann als Ersatz für die Verwendung des Loop Terminals 

dienen
• Anzahl der Terminalelemente entspricht Anzahl der Umläufe
• Run Arrow nicht gebrochen
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Array Size

Initialize Array

Gemeinsame Array Funktionen
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Array Subset

Gemeinsame Array Funktionen
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Die Build Array Funktion

Dimension erhöhen

Concatenate Inputs 

Element anhängen (append)

default 
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Die Index Array Funktion

Element extrahieren

Ein Element der Reihe extrahieren

Reihe extrahieren
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Funktionseigänge können verschieden Datentypen besitzen
Alle arithmetischen Funktionen LabVIEWs sind polymorph

Scalar + Scalar

Array + Scalar

Kombination Ergebnis

Scalar

Array

Array

Array + Array

Array + Array

Array

Polymorphie
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Lektion 5
Cluster

TOPICS
Clusters - Einführung
Cluster Funktionen
Error Cluster
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Cluster
• Datenstrukturen die Daten gruppieren (wie struct
in C oder record in Pascal)

• Elements müssen entweder als Controls oder
Indicators angelegt werden

• Ähnlich wie Drähte und Litzen in einem Kabel
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1. Wähle Cluster shell 
aus Array & Cluster
subpalette

Cluster Controls und Indicators
2. Ziehe Objekte in Shell
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Creating Cluster Constants
1. Wähle Cluster 

Constant shell aus
der Cluster
subpalette

2. Ziehe Objekte in Cluster shell
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Cluster Order
• Elemente besitzen Logische (Start mit 0)
• Wähle Reorder Controls in Cluster... um Reihenfolge zu ändern
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Verwendung von Clustern um Daten in  SubVIs
zu bringen

Cluster geeignet um komplexe
Informationen an Terminals zu
bringen

Eliminiert 28-Terminal Limit 

Vereinfacht Verdrahtung
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Cluster-Funktionen - Bundle

Bu
nd

le
Bu

nd
le 

By
 N

am
e

Neuen Cluster erzeugen Existierenden Cluster  modifizieren

Braucht existierenden
Cluster
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Cluster Funktionen - Unbundle

Unbundle Unbundle By Name
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Error Cluster
Error In und Error Out Elemente sind essentiell für das
Fehlermanagement in VIs

(zu finden in Controls»Array & Cluster Palette)
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Error Cluster Details

• Status Boolscher Wert “TRUE” bedeutet Fehler
• Code 32-bit Integer mit Vorzeichen der die 

Fehlernummer zurückgibt. 
– Code gleich 0 und Status= False Kein Fehler
– Code ungleich 0 und Status= False Warnung
– Code ungleich 0 und Status= True Fehler

• Source String mit Angabe über Fehler und Fehlerort.
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Error Handling with Clusters
• LabVIEW handelt Fehler nicht automatisch
• LabVIEW Fehlkerbehandlung funktioniert nach

Datenflussprinzipien) 
• Daisy Chain Architektur (Cluster wird durch alle SubVIs geführt; VIs

die einen Fehler am Eingang haben werden nicht ausgeführt!) 

Error Cluster
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Simple Error Handler

Simple Error Handler ist geeignet für Fehlerbehandlung nach dem
Datenfluss ( in Functions»All Functions»Time and Dialog palette)
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Verwendung von While Loops für das
Error Handling

Error Cluster direkt mit Abbruchbedingung verdrahtbar (Schleife
bricht bei Fehler=wahr ab – aut. Selektoin des Booleans “Error”
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Lektion 6
Daten plotten

Themen
Waveform Charts
Waveform und XY Graphs
Intensity Graphs
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Waveform Charts
Zu wählen in Controls»Graphs and Charts Palette 
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Charts verdrahten

Single-Plot Chart

Multiple-Plot Chart
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Chart Properties anpassen
• Erscheinungsbild

ändern
• Format und 

Auflösungen der
Achsen vändern
Plottyp wählen

• Skalen ändern
• Dokumentation/Tip 

Strip
• Etc.
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Charts und Graphs anpassen
Visible Items anwählen ermöglicht Ein- und Ausblenden der Elemente:
• Plot Legend 
• Digital Display 
• Scrollbar 
• X and Y Scale 
• Graph Palette
• Scale Legend

Graph Palette

Scale Legend

Zoom Subpalette
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• Wählbar aus Graph subpalette
• Waveform Graph – Plot eines Arrays  in Abh. von Einzelindizes
• XY Graph – Plot eines Arrays  in Abh. von eines zweiten

Arrays
Plot Legend
(point and line 
styles)

Graph PaletteScale Legend

Graphs
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X0= 0.0

Delta X = 1.0

X0 und 

Delta X wählbar

Single-Plot Waveform Graphs
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Multiple-Plot Waveform Graphs
Jede Reihe
erzeugt eigenen
Plot: 
Initial X = 0
Delta X = 1

Jede Reihe
erzeugt eigenen
Plot mit
unterschiedliche
Strartwerten und 
Schrittweiten
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• Zwei unabhängige Arrays 
erzeugen Datenpunkte

• Relationen möglich (mehr als ein
Wert pro X-Wert)

XY Graphen
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Chart und Graph Anwendung - Sonstiges
Kontexthilfe ist sehr nützlich in Zusammenhang mit Charts und Graphs
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Intensity Plots und Graphs

• Useful in displaying terrain, temperature patterns, spectrum analysis, and 
image processing

• Data type is a 2D array of numbers; each number represents a color
• Use these options to set and display color mapping scheme
• Cursor also adds a third dimension
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Lektion 7
Entscheidungsfindung in VIs

Themen
Die Select Funktion
Case Strukturen
Formelknoten
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Einfache Entscheidung: Die Select Funktion
• WennTemp Scale TRUE ist, wird der obere Zweig durchgeleitet
• WennTemp Scale FALSE ist, wird der untere Zweig durchgeleitet

• Bei komplexeren Operationen mit mehr als zwei Optionen ist die 
CASE Struktur zu verwenden
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Boolean Case Structure Beispiel:
Wenn Temp Scale TRUE ist, wird die TRUE Case Instanz abgearbeitet
Wenn Temp Scale FALSE ist, wird die FALSE Case Instanz
abgearbeitet

Case Structures
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• In der Structuren
subpalette der
Funktionspalette

• Umschließe Knoten
oder ziehe sie in 
Struktur

• Wie Karten gestapelt –
eine Instanz pro Fall

Case Structures
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Boolean und Numeric Cases

Verdarhte alle möglichen Ausgänge der Case Struktur
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String, Enum und Error Cases

String Case             Enum Case             Error Case
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• In der Strukturensubpalette wählbar
• Möglichkeit zur Erzeugung komplexer Gleichungen
• Variables wedren am Rand erzeugt
• Variablennamen sind casesensitiv (Groß- und Kleinschreibung beachten)
• Semicolon (;) erforderlich als Abschluss
• Context Help Fester zeigt Optionen an

Note semicolonFormelknoten
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Entscheidungsfindung mit Formelknoten

Zwei unterschiedliche Wege, die zum Ziel führen
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Lektion 8
Strings und File I/O

Themen
Wie man String Controls und –Indicators erzeugt
Dei String Funktionen an Hand von Einzelbeispielen
Wie mach man Dateiewin- und –ausgabe?
Wie benutzt man High- und Low Level VIs
Wie formattiert man Text um ihn dann in Tabellendateien
verwenden zu können
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• Sequenz aus (nicht) anzeigbaren Zeichen (ASCII)
• Hinweise anzeigen, Kommunikation mit Messgeräten und Dateien, etc.
• String control/indicator befinden sich in Controls»String Subpalette

Strings

110

String Display Modi
Normal display

Password display

\ code display

Hex display
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Concatenate Strings
(spaces here)

String Length

String Functions

112

String Functions
String Subset

Match Pattern
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Wandeln von Numerics inStrings: Build String

114

Wandeln von Strings in Numerics: 
Scan From String
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Edit Format String
Scan From String Function
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File Input und Output

Vier Hierarchieebenen:
High-level File VIs
Intermediate File VIs and Functions
Advanced File Functions subpalette
Express VIs
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• Write to Spreadsheet File

• Read from Spreadsheet File

• Write Characters to File

• Read Characters from File

• Read Lines from File

High-level File I/O VIs
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File I/O Programmiermodell - Intermediate

Open/
Create/

Replace File

Read 
and/or

Write to File

Close 
File

Check for
Errors
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Daten in Dateien schreiben
• Open/Create/Replace öffnet file TEST1.DAT und erzeugt refnum

und error cluster
• Write File schreibt Daten
• Close File schließt Datei
• Simple Error Handler überprüft ob Fehler erzeugt wurden
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Daten aus Dateien lesen
• Open/Create/Replace öffnet file in Abhängigkeit von der

Benutzerauswahl und erzeugt refnum und error cluster
• Read File liest Daten
• Close File schließt Datei
• Simple Error Handler überprüft ob Fehler erzeugt wurden
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Spreadsheet Strings editieren
• Spreadsheets sind populäre Tools für das Datenhandling und die 

-analyse
• Die  tab-delimited spreadheets sind die gebräuchlichsten einer

Vielzahl von Tabelledateienformaten
– Spalten sind durch Tabs getrennt
– Zeilen sind durch End of Line Zeichen getrennt

Tab End of Line

A spreadsheet yields:

122

Erzeugen von Spreadsheet Files
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Write LabVIEW Measurement File
• Besitzt open, write, close und error handling 
Funktionen

• Tab- or Komma-Trennzeichen verwendbar
• Merge Signals function wird benutzt um Dynamische
Datentypen zu erzeugen
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Lektion 9
Datenerfassung und Waveforms

Themen
Plug-in DAQ Geräte
Datenerfassung in LabVIEW
Analog Input
Data Logging
Analog Output
Counter
Digital I/O
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Übersicht und Konfiguration

Aufgae der DAQ System ist die Umsetzung von 
“Real-World”-Signalen in maschinenlesbare
Werte

DAQ Systeme bestehen aus:
•Sensoren
•Signalkonditionierung
•Plug-in DAQ Geräte
•Treiber
•Software
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Measurement 
Software 
Framework

NI-DAQ enthält
•Traditional NI-DAQ
•NI-DAQmx
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DAQ Hardware Konfiguration

Measurement & Automation Explorer (MAX)
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Channels und Tasks

Signals
ai 0
ai 1
ai 2

Sine Wave 1

Sine Wave 2

Sine Wave 3

Channel names

Tasks
Timing and Triggering
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The DAQ Signal Accessory
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Datenerfassung in LabVIEW

Traditional NI-DAQ
Specifische VIs für
• Analog Input
• Analog Output
• Digital I/O
• Counter operations

NI-DAQmx
Next Generation 
Treiber: 
• VIs um Tasks 
abzuarbeiten
• Set von VIs für alle

Aufgaben
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NI-DAQmx Datenerfassung

Satz an VIs die 
Analog I/O, Digital I/O und Counter 
Operationen erlauben

DAQ Assistant Express VI
• Einfache Programmerstellung
• Erzeugt lokalen Task
• Die meisten Appliaktionen können DAQ Assistant Express VI verwenden

132

NI-DAQmx Data Acquisition Task Types

Measurement types:
•Analog Input
•Analog Output
•Counter Input
•Counter Output
•Digital I/O
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Analog Input

Analog Input task ist
messgerätespezifisch
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Analog Input Task Timing and Triggering

Konfiguriert Abtastrate und 
Anz. An Abtastungen

Konfiguriert Start- und 
Referenztrigger
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Data Logging
• Oft ist permanente Speicherung von Messdaten erforderlich
• LabVIEW kann Measurement Files lesen und schreiben
• LabVIEW Measurement File sind ASCII Textdateien
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Analog Output
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Analog Output Task Timing and Triggering

Konfiguriert Abtastrate und 
Anz. An Abtastungen

Konfiguriert Start- und 
Referenztrigger
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Counters
Ein Counter (Zähler) ist eine digitales Timinggerät
Counteranwendungen:
• Event counting
• Frequency measurement
• Period measurement
• Position measurement
• Pulse generation

Gate

Source

Output

Count Register

Count register – Speichert den aktuellen Zählerstand
Source – Eingang der den Counter zum Weiterzählen bringt beim
Toggeln am 
Gate – Eingang mit Enable- und Disable-Funktion
Output – Signal, das Pulse oder Muster ausgibt
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Digital Input und Output
• Digital I/O können

Leitungen und 
Ports lesen und 
schreiben

• Ein digitaler Port 
besteht aus
mehreren
Leitungen
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Lektion 10
Instrument Control

Themen
Instrument Control - Übersicht
GPIB Communication und Configuration
Instrument I/O Assistant
Virtual Instrument Software Architecture (VISA)
Instrument Drivers
Serial Port Communication
Waveform Transfers
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Instrument Control - Überblick
Wenn folgendes bekannt ist kann jedes Gerät angesprochen werden:
– Steckertyp − Kabeltyp
– Eelktrische Eigenschaften des Gerätes − Kommunikationsprotokolle
– Software Treiber verfügbar

Instruments Computer

GPIB Kommunikation

GPIB Instruments

GPIB 
Cable

GPIB Interface
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GPIB Standardisierung
1965

1987

1990

1992

1993

1975

HP designs HP-IB (Hewlett Packard Interface Bus)
HP-IB becomes IEEE 488

IEEE 488.2 adopted
IEEE 488 becomes IEEE 488.1
SCPI (Standard Commands for Programmable 
Instruments) added to IEEE 488.2

IEEE 488.2 revised

HS488 proposed

1999 HS488 approved
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GPIB Hardware Spezifikationen
• Max. Kabellänge zw. Geräten

= 4 m (2 m Durchschnitt)
• Max. Kabellänge = 20 m
• Max. Anz. An Geräten = 

15 (max. 2/3 angeschaltet)1

12

13

24

DIO5
DIO6
DIO7
DIO8
REN
GND (TW PAIR W/DAV)
GND (TW PAIR W/NRFD)
GND (TW PAIR W/NDAC)
GND (TW PAIR W/IFC)
GND (TW PAIR W/SRQ)
GND (TW PAIR W/ATN)
SIGNAL GROUND

DIO1
DIO2
DIO3
DIO4
EOI
DAV

NRFD
NDAC

IFC
SRQ
ATN

SHIELD



GPIB Software Architecture — Windows

Driver 
Software
(*.DLL)

Instrument 
Driver VIsNI-VISA

LabVIEW

Diagnostics Tools:
GPIB Diagnostic Tool

NI-Spy

Configuration Tools:
Measurement & 

Automation Explorer

Interface Board
(GPIB, PXI, 

VXI, computer 
based, etc.)
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Konfiguration von GPIB Boards und 
Instrumenten

Measurement & Automation Explorer (MAX)
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Was versteht man unter dem Instrument I/O Assistant?

• Zugriff mittels LabVIEW 
Express VI

• Geräte Sets Up
• Kommunikation und 

schrittweises Datenparsing
durch
Kommunikationsinterface

148

Kommunikation mit einem Instrument
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Virtual Instrument Software Architecture

• Platformunabhängig
• VISA ist das Rückgrat der

IVI and Plug & Play 
Instrument Drivers

• Interfaceunabhängig
• SCPI command set muss 

bekannt sein um mit VISA 
zu interagieren

GPIB VXISerial PXI

VISA
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VISA Terminology
• Resource—Instrument, Serial Port oder Parallel Port
• Session— Verbindung/Handle zur Ressource
• Instrument Descriptor—Resource location

– Format: Interface Type::Address::INSTR
– Beispiele:
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Instrument Descriptor Syntax
• Resource Name enthät Interface Info
• VISA Aliases funktionieren auch

Interface Resource Name Grammar

Serial ASRL[board][::INSTR]

GPIB GPIB[board]::primary address[::INSTR]

VXI VXI[board]::VXI logical address[::INSTR]

GPIB-VXI GPIB-VXI[board][::GPIB-VXI primary 
address]::VXI logical address[::INSTR]
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VISA Resource Name

• Exakter Name und Lage des Instrumentes
• Benutzte VISA Resource Name control
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Instrument Drivers
• Mehr als 1600 LabVIEW Instrumententreiber

• Programmierung durch high-level API stark vereinfacht
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Installation und Zugriff auf Instrumententreiber
• Treiber herunterladbar: ni.com/idnet

• Treiberbibliotheken sind ind das LabVIEW 
8.x\instr.lib Verzeichnis zu installieren

• Zugriff unter der Functions»Input»Instrument Drivers 
Subpalette
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IDNET - Instrument Driver Network

• Infos über Treiber
• Hilfe zum Entwickeln von Treibern
• Möglichkeit zum Hochladen und 

Herunterladen von Treibern
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Instrument Driver Model
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• Initialize • • •

• Configure • • • • • • • •

• Action/Status • • • • • • • • • • • •

• Data • • • • • • • • • • • • • • • • • • • • • • • • • •

• Utility • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •

• Close • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •

•

Instrument Driver VIs
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Instrument Driver Inputs und Outputs

• Instrument Descriptor
• VISA Sessions 

- Verbindung oder Link zu einem Gerät
- Erzeugt nach Initialisierung
- Innerhalb einer VI Instanz zu verwenden

• Error cluster

HP34401A Initialize.vi
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Putting It All Together

• Konstruktor (Initialize 
instrument

• Methoden (Do operation(s))
• Destruktor (Close instrument)
• Check error status
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Serielle Kommunikation
• Populäre Form der Kommunikation zwischen PC und Peripheriegeräten
• Daten werden bitweise gesendet
• Niedrige Datenraten über lange Distanzen
• Nur ein Kabel wird benötigt, jedoch “Legacy”-Technologie, die auf den 

modernen Mainboards immer mehr verschwindet

RS-232 Instrument

RS-232 Cable

PC Serial
Port
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Serial Hardware Interfaces
• RS-232

– DCE oder DTE 
– 9-pin or 25-pin

• RS-422
– DCE oder DTE
– 8-pin

• RS-485
– Multidrop

Pin DTE DCE

1 DCD Input Output
2 RxD I O
3 TxD O I
4 DTR O I
5 Com - -
6 DSR I O
7 RTS O I
8 CTS I O
9 RI I O
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Serielle Kommunikation

Terminologie
• Baud rate – bits per second
• Data bits – Invertierte Logik mit LSB am Anfang
• Parity – optionales error-checking bit
• Stop bits – 1, 1.5, or 2 invertierte bits am Datenende
• Flow control – Hardware und Software Handshaking möglich
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Instrument I/O Assistant mit Seriellen Geräten

• Wähle COMX als
Geräteadresse

• Benutze den  I/O 
Assistant wie
unter GPIB
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Lektion 11
VI Anpassungen

Themen
Front Panel Erscheinungsbild ändern
SubVI Front Panels
Keyboard Shortcuts
VI Properties
Paletten anpassen
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VI Properties anpassen
• Rechtsklick auf Icon Pane zum Ändern der VI Properties 
• Hat Auswirkungen auf alle Instanzen des VIs in allen

Applikationen
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Window Appearance
Wirkt sich nur im RUN-Mode aus
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Window Size
• Setzen der Minimum Panel Größe (wichtig zum

Anpassen an Zielmonitor)
• Dynamische Größenanpassung mit Vorsicht zu

genießen
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Pop-Up Panels erzeugen
• Benutzung bei Top-Level Application Fenstern oder Dialogarten angeraten
• Kundenspezifisch anpassbar
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Erzeugung von Pop-Up Panels – Single 
Instance
Zugriff auf SubVI Node Setup durch Rechtsklick auf subVI Icon 
auf aufrufendem VI-Diagramm
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Key Navigation
Zuweisung von Shortcuts auf 
Frontpaelelemente


